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This document provides late-breaking or other general information about Microsoft Windows CE mobile 
devices, including Pocket PC, Handheld PC (H/PC), and Palm-size PC (P/PC) devices. It supplements the 
Microsoft ActiveSync 3.5 Read Me file in this folder to provide device-specific information.
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________________________________________________________________
1.1 GENERAL ISSUES

· Browsing the Web or synchronizing a large number of mobile favorites can cause your device to run low on 
storage space. To free storage space, open Pocket Internet Explorer and tap Tools > Options. Then, on the 
General tab, tap Delete Files to delete all Web pages stored on your device, including offline favorites content.

· If a network card is inserted in the CF slot and the device is on battery power, the device will not shut off 
automatically after you, a reminder, or an alarm powers the device on. The device will remain on until it runs 
out of power, regardless of whether the network card is actually in use or not.

________________________________________________________________
1.2 CONNECTIONS

· Tapping the IR ActiveSync icon while ActiveSync is already connected to your device will frequently cause 
ActiveSync to stop responding, even though it looks like it is still active. To restart ActiveSync, disconnect and 
reconnect your device.

· After tapping an icon to start a network connection, entering a domain name using the Word Completion feature
of the input panel will cause a space to be automatically added after the name. Remove this space before 
tapping Connect; otherwise the connection will fail.

________________________________________________________________
1.3 MICROSOFT POCKET OUTLOOK

INBOX

· LDAP (name resolution against an online address book server) authentication is not supported when using 
Exchange 5.0 and 5.5 servers. If the server does not require LDAP authentication, name resolution functions 



correctly.

NOTES

· In order to synchronize notes with your device, Microsoft Outlook 2000 (or later) must be installed on your 
desktop computer. Once Outlook is installed, ActiveSync enables the Notes sync option. To select this option 
for synchronization, open ActiveSync, click Tools, click Options, and then select the Notes check box.

· If your notes are appearing as mail messages (this is common when viewing Outlook notes from a second 
desktop computer that does not have Microsoft ActiveSync 3.1or later installed), do the following:

1. On the desktop computer, install ActiveSync.
2. When the Get Connected Wizard appears on the screen, click Cancel so that no partnership is 

created.
3. Open Microsoft Outlook.
4. Locate and open the Microsoft ActiveSync folder (the default location is \Program Files\Microsoft 

ActiveSync). Then, double-click on the file, forminst.exe, to install the forms necessary to view ink 
and voice notes properly.

5. Quit Outlook. The changes will take effect the next time you open Outlook.

· Once a note that contains ink or voice recordings has been deleted (that is, moved into the Deleted Items 
folder) in Microsoft Outlook, the note cannot be moved back into the Notes folder.

· If both the Files and Notes sync options are selected in Microsoft ActiveSync, only notes and sound 
(e.g. .WAV) files will be synchronized with Outlook. All other files will be synchronized to the Synchronized 
Files folder on your desktop computer.

________________________________________________________________
1.4 MICROSOFT POCKET INTERNET EXPLORER

· Pocket Internet Explorer provides a single window for browsing and viewing Web pages. Web sites or 
hyperlinks that launch additional browser windows will not do so when viewed with Pocket Internet Explorer.

· Browsing the Web or synchronizing a large number of mobile favorites can cause your device to run low on 
storage space. To free storage space, open Pocket Internet Explorer and tap Tools > Options. Then, on the 
General tab, tap Delete Files to delete all Web pages stored on your device, including offline favorites content.

· Tapping a link to a file downloads the file and then opens the file using the appropriate program for that file. If 
no program is available to handle the file, the file will still be downloaded and placed in a folder within \
Windows\Temporary Internet Files.

· If you download the Microsoft Mobile Channel Wizard from the Microsoft Windows CE Web site and used this 
wizard to create mobile channels, these channels will not work with Pocket Internet Explorer on the Pocket PC. 
Instead, create mobile favorites using Microsoft Internet Explorer 5 (or later) on your desktop computer (see the
User’s Guide for details). Channels that have been specifically designed as mobile channels, not just created 
using the wizard, will continue to work normally.

· On the Tools menu, the Disconnect command will only close connections that were started from Pocket 
Internet Explorer.

· Pocket Internet Explorer supports JScript, but does not support DHTML, VBScript, or Java.
________________________________________________________________
1.5 MICROSOFT POCKET EXCEL

 To enable a four-digit year format in all Pocket Excel workbooks (as well as in all programs on the device), 
open Settings, tap the System tab, and double-tap Regional Settings. Tap the Date tab and, in Short date, 
select MM/dd/yyyy or M/d/yyyy format. To only change the date format in a specific Excel workbook, create a
custom date format for that workbook.

CONVERSION TO/FROM POCKET EXCEL

· Pocket Excel has a 255-character limit for each cell. Any characters beyond 255 will be lost during conversion.
· Cells that contain formulas of the form "=name" and "=name+name", where "name" is a defined name, may not

recalculate correctly in Microsoft Excel 97/2000 after conversion. To resolve this, on the Edit menu, click 



Replace, enter "=" for both the Find what and Replace with boxes, and then click Replace All. This causes 
Excel to recalculate the formula using the correct values.

· Defined names that refer to many levels of nested IF() functions may get lost during conversion from Pocket 
Excel to Excel 97. To work around this problem, reduce the number of nested IF() statements used in the 
defined name.

· Although Microsoft Excel 97 (and later) supports 65536 rows, Pocket Excel supports only 16384 rows. Rows 
beyond this are deleted upon conversion from Excel 97/2000 to Pocket Excel.

· Microsoft Excel 97 (and later) provides a conditional number formatting feature. Cells formatted using this 
feature may not be displayed properly in Pocket Excel.

· When converting from Microsoft Excel to Pocket Excel, many formats are listed under the Custom category 
(Format>Cells>Number) since Pocket Excel uses this category to list all the number formats it supports.

· When converting a file from Microsoft Excel, a list that has been filtered using AutoFilter will not be filtered in 
Pocket Excel. However, if the filtering resulted in some rows being hidden, these rows will also be hidden in 
Pocket Excel. To display the rows in Pocket Excel, first select a cell in the hidden row by tapping Tools>Go to, 
typing a reference, and tapping OK. Then tap Format>Row and tap Unhide.

________________________________________________________________
1.6 MICROSOFT POCKET WORD

CONVERSION TO/FROM POCKET WORD

· On the desktop computer, the conversion process uses the Word converters installed by Microsoft Office. If 
you receive a message during file conversion indicating that a particular converter cannot be found, reinstall 
Microsoft Office on the desktop computer and turn on all filter/conversion options during setup. Note that in 
Office 2000, most converters are not installed directly onto your computer by default. Converters not installed 
directly on your computer will not work correctly with Microsoft ActiveSync. To enable these converters in 
Office 2000, click Control Panel, double-click Add/Remove Programs, select Microsoft Office 2000, and 
click Change. When the Office Setup dialog box appears, click Add or Remove features, click on Converters 
and Filters, select Run all from My Computer, and then click Update Now.

· When you convert a Pocket Word file from your device to an HTML file on your desktop computer, the pictures
in the Pocket Word file may be lost due to a problem in one of the converters supplied by Microsoft Office 97. 
To fix this problem, download and install the Microsoft Office 97 Service Release 1 (SR-1) from 
http://www.microsoft.com/office/.

· When converting a file from Pocket Word to Microsoft Word (.doc or .rtf) on either your desktop computer or 
your device, lists that contain multiple styles of numbering (for example, where the first line is a number, 
second is a bullet, and third is a letter) may be formatted with a single style of numbering.

· Pictures are generally not retained when you use the Word converter on your device to open a .doc file. To 
ensure proper display of the pictures in your document, convert your document using ActiveSync on your 
desktop computer instead of the converter on the device.

· When Microsoft Word documents are repeatedly converted between the desktop and the device, embedded 
picture quality can be significantly degraded. Avoid repeated conversion of documents that contain pictures.

· The Microsoft Word converter on the device removes metafiles when the file is opened. To preserve these 
pictures in your document, convert the document using ActiveSync on your desktop computer instead of the 
converter on the device.

________________________________________________________________
1.7 COMPATIBILITY WITH PALM-SIZE PC PROGRAMS

· If you have a third-party program developed for previous versions of Pocket PC and you had to tap on a taskbar 
icon to open this program, you will only be able to open this program from the Today screen. This screen is the 
only screen that has icons available in the lower-right corner.

________________________________________________________________
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________________________________________________________________
2.1 GENERAL ISSUES

· If your H/PC supports backlighting, you may have a Backlight tab in Control Panel Display. On some H/PCs, 
the Advanced button may be disabled if the device does not support advanced features.

· If you are printing via a serial connection and you disconnect and reconnect your cable, strange characters may 
appear at the top of your printout. After disconnecting your cable, turn off your printer before reconnecting to 
clear the printer buffer of any extraneous information.

· File names that contain Russian characters cannot be opened on H/PC Professional devices. Rename files so 
that names do not include Russian characters.

· If your username is eight characters or longer, you may get an erroneous error message when trying to print to a
network printer. The message will state that a network error occurred when in fact the print job prints 
successfully.

· On mouse-based devices, the wait cursor may not always be displayed when performing certain actions, for 
example, when opening documents from a network drive that require conversion or when attempting to connect 
to a network drive by using the Run command on the Start menu. It will appear as though nothing is 
happening; however, the process will be completed.

· Some modems do not support dial strings with more than 40 characters. If you encounter this problem, 
configure the modem to use manual dialing by selecting your dial-up connection, selecting Properties on the 
File menu, selecting the Configure button, and then selecting Manual Dial.

________________________________________________________________
2.2 MICROSOFT POCKET INTERNET EXPLOER

· Microsoft Pocket Internet Explorer does not support the following tags:    <INPUT TYPE="FILE">, <TABLE 
ALIGN="">, and <IMG ALIGN="">. However, the <TD ALIGN=""> tag is supported.

· DHTML, VBScript, and Java are not supported. JScript is supported.

· Forms that use "action" as the name for a form element will not work. The property name "action" is reserved.

· The "OnFocus" event is not supported in the JScript implementation. However, the "OnChange" event is 
supported.

________________________________________________________________
2.3 MICROSOFT POCKET OUTLOOK

INBOX

· Users using Exchange Server to receive e-mail via POP3 or IMAP4 can also receive meeting requests on their 
devices. Your administrator must enable this feature by turning on Rich Text Format on the server. However, 
doing this has some drawbacks:

· Users will no longer be able to receive attachments that have been sent internally through other e-mail 
clients, such as Outlook Express.



· Embedded objects and messages will be removed by the server.
· Users will not be able to identify whether a message had attachments unless the entire message and 

attachments have been completely downloaded; therefore, attachments may not be downloaded 
interactively.

·
· Some servers, such as Sun Solstice and HP OpenMail, do not support partial downloading of message bodies. 

Therefore, if Download n lines is selected on the Properties tab when configuring the account, these servers 
will not download messages. To work around this problem, change your device Inbox options for the server to 
Download full copy.

· Inbox attempts to use the highest level of authentication possible when communicating with a server. This 
includes trying several methods of authentication to determine which method the server will accept.    Nplex 
Isocor POP3 servers, by default, only allow three authentication attempts before canceling the connection. To 
use Inbox with this server, your administrator must change the settings on the server to allow up to eight 
authentication attempts. 

________________________________________________________________
2.4 MICROSOFT POCKET WORD

· If you lose your network connection while attempting to open a .doc file from a network drive, your device may
appear to be hung when in fact it is taking longer than expected to return an error message. In these cases, your 
device will eventually display an error message about the file being inaccessible.

CONVERSION TO/FROM POCKET WORD

· The Pocket Word conversion process uses other converters installed by Microsoft Office. If you receive an error
message during file conversion indicating that a particular converter cannot be found, reinstall Microsoft Office 
on the desktop and turn on all filter options during setup.    Then reinstall ActiveSync.

· When you convert a Pocket Word file on your H/PC to an HTML file on your desktop computer, the pictures in 
the Pocket Word file may be lost. This could be due to a problem in one of the converters supplied by Microsoft
Office. This problem is addressed in the Microsoft Office 97 service release (SR-1), which you can download 
from http://www.microsoft.com/office/.

· When you convert a file from Pocket Word to Microsoft Word .doc or .rtf format on your desktop computer or 
on your device, lists that contain multiple styles of numbering (for example, where the first line is a number, 
second is a bullet, and third is a letter) may be formatted with a single style of numbering.

· Clip art objects are not retained when converting from Microsoft Word to Pocket Word on the desktop. To work 
around this problem, you can convert your clip art objects to bitmaps by selecting the object, copying it, and 
then paste it as a bitmap using the Paste Special command in Microsoft Word. All objects will then be 
converted without a problem.

· Pictures are generally not retained when you open a .doc file on your device using the device side .doc to Pocket
Word converter. To ensure proper display of the pictures in your document, convert your document on your 
desktop computer using ActiveSync.

________________________________________________________________
2.5 MICROSOFT POCKET EXCEL

· Pocket Excel implements minimal support for local defined names to be compatible with Microsoft Excel 
97/2000. If you must use local names, you should avoid creating duplicate local and global names.

· The Microsoft Excel feature that enables you to change the currency symbol in the Format Cells dialog box is 
not supported in Pocket Excel. Pocket Excel is unable to save files that use this feature.

· Adding a custom number format results in additional custom number formats that appear as unrecognized 



characters (blank squares). The additional formats are usable UNICODE format strings for formats such as 
Chinese dates. These special formats are not displayed until the user explicitly puts in a custom format.

· When printing a worksheet with cells that are formatted with the "Automatic" color fill, the cells will print using
the "Window Background" color specified in Control Panel Display. To work around this problem, change the 
fill of the cells to white instead of automatic.

CONVERSION TO/FROM POCKET EXCEL

· Pocket Excel 1.0 documents that contain 3D references cannot be converted to Pocket Excel 2.0/3.0 format. To 
work around this problem, remove the 3D references from the file, convert the document to Excel 2.0/3.0 
format, and re-enter the 3D references.

· Cells that contain the COUNTBLANK() function may display #VALUE! in Excel 97/2000 after being edited in 
Pocket Excel and then converted to Excel 97/2000. To resolve this, do a Replace All that searches for "=" and 
replaces it with "=".

· Cells that contain formulas of the form "=name" and "=name+name", where "name" is a defined name may not 
recalculate correctly in Excel 97/2000 after conversion. To resolve this, do a Replace All that searches for "=" 
and replaces it with "=".

· Defined names that refer to many levels of nested IF() functions may get lost during conversion from Pocket 
Excel to Excel 97. To work around this problem, reduce the number of nested IF() statements used in the 
defined name.

· Microsoft Excel 97 and later supports 65536 rows. Pocket Excel supports 16384 rows. Rows beyond this are 
deleted upon conversion from Excel 97/2000 to Pocket Excel.

· Microsoft Excel 97 and later provides a conditional number formatting feature. Cells formatted using this 
feature may not be displayed properly in Pocket Excel.

· When converting from Pocket Excel to Microsoft Excel, many formats are added to the Custom category in the
Format Cells dialog box in Microsoft Excel on your desktop computer. Pocket Excel displays all number 
formats it supports.

· Column formatting may be lost during conversion where it intersects with formatting applied to an entire row. 
For example, if you have a row with a non-default height and all other attributes are defaults, column formatting
information, such as borders, will be lost where the column(s) and row(s) intersect when converting from 
Microsoft Excel to Pocket Excel. If you reapply the formatting in Pocket Excel, the formatting will not 
subsequently be lost in the conversion process again.

· When you convert a file from Microsoft Excel to Pocket Excel, AutoFilter activation is not retained. However, 
if your AutoFilter activation resulted in some rows being hidden, these rows are also hidden in Pocket Excel. To
display the rows, unhide them in Pocket Excel.

_______________________________________________________________
2.6 MICROSOFT POCKET POWERPOINT

· Pocket PowerPoint can require a lot of memory to display complex graphics. You may need to allocate more 
RAM to Program Memory using Control Panel System.

· Pocket PowerPoint uses a caching scheme to improve performance when navigating forward and back through 
a presentation. To minimize delays when advancing slides during a show, it is recommended that you spend at 
least 5-10 seconds on each slide before advancing to the next. This will allow the next slide image to be cached 
and ensure a quick transition. The size of the cache is directly related to the availability of Program Memory. 
Also, this cache is automatically flushed if another program requests additional memory.



· To display a presentation on an external monitor, your device must have a VGA port or a compatible VGA PC 
Card.

· You cannot apply a font size greater than 645 to your title slide.

CONVERSION TO POCKET POWERPOINT

· When converting a PowerPoint 2000 file, some slides may appear black. This problem occurs on the H/PC 
Professional Editions, v3.0. This problem is fixed in Service Pack 1 for the H/PC Pro. Please contact your OEM
to download SP1.

· The Pocket PowerPoint conversion process uses PowerPoint 97 and 2000 for file conversion. If you receive an 
error message during file conversion indicating that a particular converter cannot be found, reinstall Microsoft 
Office on the desktop and turn on all graphic filter options during setup.    Then reinstall ActiveSync on your 
desktop computer.

· Avoid using animations and gradient fills in PowerPoint 97/2000 presentations that you plan to convert to 
Pocket PowerPoint. The animation may be partially depicted in the slide image, and the gradient fills may 
appear different from those on a PC with more available colors and higher resolution.

· "Compact" style file conversion notes: 1) Check your presentation carefully after conversion. If the presentation
file uses fonts not installed on your H/PC, you may encounter text wrapping and layout problems. These can 
best be avoided by using an H/PC installed font or copying the additional fonts to your H/PC's \Windows folder.
2) For best results, it is recommended that all text in the original presentation be formatted with line spacing set 
to 1 and space between paragraphs set to 0. 3) Slide background images are copied from the Master and Title 
Master Slides and used for all slides in the presentation. If a particular slide uses a custom background, it will be
lost during the conversion, and the Master Slide background will be used instead.

· During conversion, a number of temporary files will be created in your desktop computer's \Windows\Temp 
folder. Under certain conditions, these temporary files may not be automatically deleted, and you may need to 
manually delete them from time to time.

_______________________________________________________________
2.7 MICROSOFT POCKET ACCESS

· ActiveSync on your desktop computer will hang when attempting to convert a database file that contains a table
that is named with a double quote character as the only character. The documentation states that this is not a 
legal character in a table name. The hang only occurs if it is the sole character.

· In the Import from Database to Mobile Device dialog box, you can browse to the target location where you 
want the database on your mobile device to exist. The Browse dialog box does not reflect other storage devices,
such as a PCMCIA Flash Card or a Compact Flash Card. You must manually type these locations in the dialog 
box. 

· When using the Import from Database to Mobile Device dialog box to specify the target location of the 
database on your mobile device, an erroneous error may occur if the location does not exist. To work around 
this, dismiss the error messages and retype the location.

· If you attempt to filter for a double quote character ("), Pocket Access will quit after dismissing the incorrect 
syntax error message. This problem occurs on the H/PC Professional Editions, v3.0. This problem is fixed in 
Service Pack 1 for the H/PC Pro. Please contact your OEM to download SP1.

· If you lose your network connection while attempting to open a .cdb file from a network drive, your device may
appear to be hung when, in fact, it is taking longer than expected to return an error message. In these cases, your
device will display an error message about the file being inaccessible.



· When synchronizing a password-protected .mdb file and .cdb file, you will be prompted to enter the password 
each time you synchronize. This causes a problem when you synchronize remotely and are not at your desktop 
computer to enter the password. Synchronization cannot continue until you enter the password.

· If an error occurs when you attempt to convert an .mdb file to a .cdb file, check the version number in the file 
properties for Odbc.dll located in your Windows\System directory. You must have driver version 3.00.2301 or 
later. Note that this driver is not installed by default when you do a typical installation. If you do not have this 
driver or if you have the wrong version, you can install it by running Office 97 or Access 97 Setup and selecting
this component.

· When you drag and drop an .mdb file to the Mobile Devices folder, it is placed in the My Documents folder 
regardless of the folder you selected. To move the location of the resulting .cdb file, click Options on the Tools 
menu in the ActiveSync window. Select Table and then click Options. Select the database name and then click 
Properties.

_______________________________________________________________
2.8 MICROSOFT INKWRITER

· Images in Word 97 documents are not handled properly when converted to InkWriter format. This can result in 
images that display artifacts such as lines or incorrect colors, or the image may be converted to random text. 
This only appears in the converted file and does not affect the images in the original Word 97 document. There 
is no known workaround for this issue at this time.

· In the Font, Ink, Drawing dialog box, you can set character and drawing format attributes. The Font Name, 
Size, and Style options apply to text you input with the keyboard or input panel. The Pen Weight, Line Color, 
and Style options apply to text you write on your screen. The Fill Color option is only used for drawings.

· When you set your Pen Weight to Bold or Thick in the Font, Ink, Drawings dialog box, the Bold option 
under Styles is also selected.

· InkWriter prints with a fixed font size and line height. As a result, the printed output will not appear exactly as it
does on your screen.

_______________________________________________________________
2.9 COMPATIBILITY WITH VERSION 2.0 PROGRAMS

· When installing PowerToys 2.0 for Windows CE on the H/PC Professional edition, you may see a warning that 
the program is not compatible with the current operating system. You can safely ignore the message and 
continue with the installation. PowerToys v3.0 for the H/PC Professional edition is available from 
http://www.microsoft.com/mobile/downloads/powtoy30.asp.

________________________________________________________________
3.0 HANDHELD PC VERSION 2.0 CONTENTS

3.1 GENERAL ISSUES
3.2 MICROSOFT POCKET INTERNET EXPLORER
3.3 MICROSOFT POCKET OUTLOOK
3.4 MICROSOFT POCKET WORD
3.5 MICROSOFT POCKET EXCEL
3.6 MICROSOFT POCKET POWERPOINT
3.7 COMPATIBILITY WITH VERSION 1.0 PROGRAMS
________________________________________________________________
3.1 GENERAL ISSUES (All Editions)

· For information about printing from your H/PC, see Help in Microsoft ActiveSync on your desktop computer.



· If your H/PC supports backlighting, you may have a Backlight tab in Control Panel Display. On some H/PCs, 
the Advanced button may be disabled if the device does not support advanced features.

· If you are printing via a serial connection and you disconnect and reconnect your cable, there may be strange 
characters that appear at the top of your print out. After disconnecting your cable, turn off your printer before 
reconnecting to clear the printer buffer of any extraneous information.

GENERAL ISSUES (Japanese Edition Only)

· You can transfer a TTC font file to your H/PC \Windows\Fonts folder using ActiveSync on your desktop 
computer. This will setup your TTC file for use in your H/PC applications. You cannot, however, transfer the 
TTC file from a PC Storage Card directly to the \Windows\Fonts folder and access it in your H/PC applications.
The transfer must occur through ActiveSync.

· To use the following PHS adapter (PIAFS) cards, change the value for "Cancel the call if not connected within" 
on the Call Option tab in Device Properties dialog box to a value within the available range below: 

Name of PHS Adapter Card               Available Range
NTT Personal 32K PALDIO 321S 0 ~ 58
NTT Personal 32K PALDIO Data Card DC-1S 0 ~ 58
NTT Personal 32K PALDIO Data Card DC-2S 0 ~ 58
NTT Personal 32K PALDIO Data Card DC-1N 0 ~ 59
NTT Personal 32K PALDIO Data Card DC-2N 0 ~ 59
NTT Personal 32K PALDIO Data Card DC-1P 0 ~ 59
NTT Personal 32K PALDIO Data Card DC-2P 0 ~ 59
Panasonic TO-PHS32K 0 ~ 59

· If you use a non-Japanese font such as Tahoma and then switch to a Japanese character input method, the font 
selection is not automatically changed to a Japanese font. When you use the IME to switch to a Japanese 
character input method, you must manually change the font.

· A folder named "Storage Card" is displayed in romaji characters in the Windows Explorer when you insert a 
memory card.

· You can transfer data via IR from a device running Windows CE v2.0 for the Handheld PC to a device running 
Windows CE v1.0 for the Handheld PC. You cannot, however, open a bitmap file from a v2.0 H/PC on a v1.0 
H/PC. In addition, you cannot open a file saved in Pocket Excel 2.0 in Pocket Excel v1.0. You must first save 
the Pocket Excel 2.0 file as a 1.0 file and then transmit it via IR to the 1.0 H/PC.

· It is strongly advised that you only use the following characters when entering a Device Name for your mobile 
device: the letters A-Z, the numbers 0-9 and the hyphen [-].    If you enter other characters such as Kanji, or 
wide English characters, etc., you may not be able to connect to some Internet Service Providers and you will 
not be able to use ActiveSync on your device to make remote connections via an Ethernet Card.

________________________________________________________________
3.2 MICROSOFT POCKET INTERNET EXPLORER (All Editions)

· Links to folders from a Web page are not supported.    To open the folder, type the link into the address bar.

· The Back button does not go to the previous page if the link to the current page is in a frame. Instead, the Back 
button goes to the page before the frame.    Links must be traversed again to get to the desired page.

· To achieve best results when using the Set as Wallpaper option with a graphic image on a Web page; do not use 
the Tile image on background option from Display Properties.    This affects grayscale devices (both 4 and 16 
shades of gray) only.

· If you save a bitmap to a file from Pocket Internet Explorer on a device that displays only four shades of gray, 



the file cannot be properly converted when transferred to a desktop computer.

· DHTML, VBScript, JScript/JavaScript, and Java are not supported.
________________________________________________________________
3.3 MICROSOFT POCKET OUTLOOK 

CALENDAR (All Editions)

· When accepting group scheduling requests via Inbox, items that were sent as "private" will not appear as private
in Calendar.    After accepting such an item it will need to be manually edited to be marked as "private" in the 
Calendar.

CALENDAR (US and European Editions)

· Specifically on HPC V2.0 - Devices that contain a MIPS processor will not allow you to enter any future 
appointments that begin at 7:00 AM. You can workaround this problem by creating the appointment directly in 
Calendar view or by changing the start time of the appointment to anything other than 7:00 AM, such as 6:59 
AM or 7:01 AM. This issue has been fixed in the Handheld PC Service Pack 1 release, available from your 
device's manufacturer.

CONTACTS (Japanese Edition Only)

· To use the Quickfind feature while sorting on either the "Name" or "Company" columns, type the Yomi name 
(rather than literal name) in the Quickfind field.

· The Quickfind feature will work completely for any name as long as it does not contain a Kana character using 
a dakuten or handakuten accent.    Quickfind is not able to distinguish properly between a regular Kana 
character and one with the dakuten or handakuten accent.    At the point one of these characters is used in a 
name, switch from using Quickfind to using the vertical scroll bar in contacts to find the address card you are 
seeking.

INBOX (All Editions)

· Restore from 1.0 backup: Linked messages are corrupted on restore. Recreate the same services using the exact 
same name. Then use the Service/Clear command and refresh for the service to download the messages again 
and restore the links.

INBOX SYNCHRONIZATION (All Editions)

· Inbox Synchronization supports the following clients: Windows Messaging Client, Microsoft Exchange, and 
Microsoft Outlook 97.    Microsoft Outlook Express is NOT supported at this time.

INBOX (Japanese Edition Only)

· If you limit the number of lines in a message that should be downloaded from your Internet Service Provider 
(ISP), you will in most cases see "Message truncated after n lines" at the end of your message. However, there 
are some ISP's that return 1 less line than asked for and as a result, Inbox thinks the message is completely 
downloaded and you will not see this text at the end of your message. This is a problem on the ISP's server.

· The maximum message size that Inbox supports is 32k. If a message you download is larger than this, you will 
see the text "Message truncated after 31k" at the end of your message. If you use QP to encode your message, 
the size of your message may increase dramatically and as a result, the chance that your message will exceed 
32k is much higher. The encoding is in the first part of the downloaded message and since Inbox stops 
downloading at 32k, part or all of the message body may be truncated. To workaround this problem, do not use 
QP to encode your message.



· When you download a copy of a full message, there may be a discrepancy between what the server reports as 
the size of the message and what the downloaded message size is. This is due to the fact that the message server 
reports the size in bytes and Inbox reports the size in characters. 

________________________________________________________
3.4 MICROSOFT POCKET WORD (US and European Edition)

· The online Help for how to use templates is incorrect. Template samples are located in the My Handheld PC\
Programs\Office\Templates folder. To create a template, save a file as a Pocket Word template in this folder. To 
use a template, tap New on the File menu, and then tap Document From Template.

· You cannot open Pocket Word 2.0 files that contain pictures in Pocket Word 1.0.

MICROSOFT POCKET WORD (Japanese Edition Only)

· In the Font, Ink, Drawing dialog box, you can set character and drawing format attributes. The Font Name, Size,
and Style options apply to text you input with the keyboard or SIP. The Pen Weight, Line Color and Style 
options apply to text you write on your screen. The Fill Color option is only used for drawings.

· When you set your Pen Weight to Bold or Thick in the Font, Ink, Drawings dialog, the Bold option under styles 
is also selected.

· Pocket Word prints with a fixed font size and line height. As a result, the printed output will not appear exactly 
as it does on your screen.

CONVERSION TO/FROM POCKET WORD (All Editions)

· The Pocket Word conversion process uses other converters installed by Microsoft Office. If you receive an error
message during file conversion indicating that a particular converter cannot be found, reinstall Microsoft Office 
on the desktop and turn on all filter options during setup.    Then reinstall ActiveSync on your desktop computer.

· When you convert a Pocket Word file on your H/PC to an HTML file on your desktop computer, the pictures in 
the Pocket Word file may be lost. This is due to a problem in one of the converters supplied by Microsoft 
Office. This problem is addressed in the Microsoft Office 97 service release (SR-1), which you can download 
from http://www.microsoft.com/office.

· When you convert a file from Pocket Word to Microsoft Word .doc or .rtf format, lists that contain multiple 
styles of numbering (for example, where the first line is a number, second is a bullet, and third is a letter) may 
be formatted with a single style of numbering.

· Clipart objects are not retained when converting from Microsoft Word to Pocket Word. To work around this 
problem, you can convert your clipart objects to bitmaps by selecting the bitmap, copying it, and then paste it as
a bitmap using the Paste Special command in Microsoft Word. All objects will then convert without a problem.

CONVERSION TO/FROM POCKET WORD (Japanese Edition)

· Bullet characters in documents that you convert from Microsoft Word 97J or later may be displayed incorrectly 
as a vertical bar or other character rather than a bullet. You must have the font that is used to display the bullet 
on your device. If the bullet is formatted in the Symbol font, it will be displayed correctly. The default font for 
bullets in the Japanese versions of Word , however, is Wingdings. You can copy the Wingdings font from the 
Fonts folder on your desktop PC to the Fonts (in English characters) folder on your device. Another workaround
is to apply the bullets in Pocket Word.

________________________________________________________________
3.5 MICROSOFT POCKET EXCEL (All Editions)

· Many operations in Pocket Excel, such as sorting, applying formatting, or applying an Autofilter, are quicker if 
you select the specific range rather than entire columns, rows, or the entire worksheet.



· The online Help information about using templates is incorrect. Template samples are located in the My 
Handheld PC\Programs\Office\Templates folder. To create a template, save a file as a Pocket Excel template in 
this folder. To use a template, tap New on the File menu, and then tap Document From Template.

· Omitting the second argument in DCOUNT and DCOUNTA results in an error value. To work around this 
problem, you can use the cell reference containing one of the headings of your database. This will behave the 
same as if you omit the second argument.

· If printing a worksheet fails and results in an error message, close your file and reopen it before printing again. 
Otherwise, depending on the complexity of the file, the available memory on your H/PC may be reduced.

· When you undo an action that you performed on a large number of cells, such as a sort, a slowdown may occur. 
Close and reopen the file to work around the problem.

· Inserting, deleting, or moving a sheet within a workbook may cause the AutoFilter arrow buttons to disappear. 
To make them reappear, reapply the AutoFilter.

· AutoFilter activation is not saved with your workbooks.

· Adding a custom number format results in additional custom number formats that appear as unrecognized 
characters (blank squares). The additional formats are usable UNICODE format strings for formats such as 
Chinese dates. These special formats are not displayed until the user explicitly puts in a custom format.

· Fractions are not always displayed correctly. Pocket Excel does not correctly limit the digits displayed in the 
fraction. The underlying value, however, is correct and can be safely used in calculations. For example, if you 
enter 1 5/12 in a cell, Pocket Excel displays it as 1 5/1; however, the underlying value is 1 5/12.

· Border formatting is shown only in the Format Cells dialog box for the cells you specifically formatted. Even 
though adjacent cells may appear to have border formatting in your worksheet, this is not reflected on the 
Border tab in the Format Cells dialog box.

· Pocket Excel implements minimal support for local defined names in order to be compatible with Microsoft 
Excel 97. If you must use local names, you should avoid creating duplicate local and global names.

CONVERSION TO/FROM POCKET EXCEL (All Editions)

· The Microsoft Excel feature that enables you to change the currency symbol in the Format Cells dialog box is 
not supported in Pocket Excel. Pocket Excel is unable to save files that use this feature.

· Microsoft Excel 97 and later supports 65536 rows. Pocket Excel supports 16384 rows. Rows beyond this are 
deleted upon conversion from Excel 97/2000 to Pocket Excel.

· Column formatting may be lost during conversion where it intersects with formatting applied to an entire row. 
For example, if you have a row with a non-default height and all other attributes are defaults, column formatting
information, such as borders, will be lost where the column(s) and row(s) intersect when converting from 
Microsoft Excel to Pocket Excel. If you reapply the formatting in Pocket Excel, the formatting will not 
subsequently be lost in the conversion process again.

· When you convert a file from Microsoft Excel to Pocket Excel, AutoFilter activation is not retained. However, 
if your AutoFilter activation resulted in some rows being hidden, these rows are also hidden in Pocket Excel. To
display the rows, unhide them in Pocket Excel.

· Microsoft Excel 97 and later provides a new conditional number formatting feature. Cells formatted using this 
feature may not be displayed properly.



· When converting from Pocket Excel to Microsoft Excel, many formats are added to the Custom category in the 
Format Cells dialog box in Microsoft Excel on your desktop computer. Pocket Excel displays all number 
formats it supports.

________________________________________________________________
3.6 MICROSOFT POCKET POWERPOINT (All Editions)

· Pocket PowerPoint can require a lot of memory to display complex graphics. You may need to allocate more 
RAM to Program Memory using System Control Panel.

· Pocket PowerPoint uses a caching scheme to improve performance when navigating forward and back through 
a presentation. To minimize delays when advancing slides during a show, it is recommended that you spend at 
least 5-10 seconds on each slide before advancing to the next. This will allow the next slide image to be cached 
and ensure a quick transition. The size of the cache is directly related to the availability of Program Memory. 
Also, this cache is automatically flushed if another program requests additional memory.

· To display a presentation on an external monitor, your device must have a VGA port or a compatible VGA PC 
Card.

· You cannot apply a font size to your title slide greater than 645.

CONVERSION TO POCKET POWERPOINT (All Editions)

· The Pocket PowerPoint conversion process uses PowerPoint 97 and 2000 for file conversion. If you receive an 
error message during file conversion indicating that a particular converter cannot be found, reinstall Microsoft 
Office on the desktop and turn on all graphic filter options during setup.    Then reinstall ActiveSync on your 
desktop computer.

· During conversion a number of temporary files will be created in your desktop computers \Windows\Temp 
folder. Under certain conditions, these temporary files may not be automatically deleted, and you may need to 
manually delete them from time to time.

· "Compact" style file conversion notes: 1) Check your presentation carefully after conversion. If the presentation
file uses fonts not installed on your H/PC, you may encounter text wrapping and layout problems. These can 
best be avoided by using an H/PC installed font or copying the additional fonts to your H/PC's \Windows folder.
2) For best results, it is recommended that all text in the original presentation be formatted with line spacing set 
to 1 and space between paragraphs set to 0. 4) Slide background images are copied from the Master and Title 
Master Slides and used for all slides in the presentation. If a particular slide uses a custom background, it will be
lost during the conversion, and the Master Slide background will be used instead.

· Avoid using animations and gradient fills in PowerPoint 97/2000 presentations that you plan to convert to 
Pocket PowerPoint. The animation may be partially depicted in the slide image and the gradient fills may 
appear different than they would on a PC with more available colors and higher resolution.

________________________________________________________________
3.7 COMPATIBILITY WITH VERSION 1.0 PROGRAMS (All Editions)

The following issues have been observed when running existing H/PC 1.0 programs on H/PC 2.0 computers. 

FONT DISPLAY

Programs that you used on Windows CE 1.0 for the H/PC are usable and functional on version 2.0. However, 
demand for improved clarity and readability on H/PCs caused two major changes that have had an impact on how 
1.0 programs and dialog boxes are displayed:

1. The system font has been changed to Tahoma 9 pt.
2. The font technology used is now TrueType, which provides programs much more flexibility and enables 



enhancements such as zooming. 

To ensure compatibility and proper display of 1.0 programs on the H/PC 2.0, every effort has been made to map 
fonts used in 1.0 program user interfaces to the closest matching font in terms of size and style available on the 
H/PC 2.0. Due to this mapping, your 1.0 programs are displayed with a smaller menu font and a smaller dialog box 
font than H/PC 2.0 programs. Still, because the fonts are being mapped to a font that is similar though not identical 
to the 1.0 fonts, you may see one or more of the following issues in your 1.0 programs:

· Words at the end of option names in dialog boxes are clipped or missing due to the string being slightly wider.

· The Close button (in the upper-right corner of the program window) is clipped due to the menu names being 
slightly wider.

· Button names are not bold.

· In a few cases, the font in your program's main window is mapped to a smaller or larger font than that displayed
in 1.0.

Finally, due to the change to TrueType font technology, any program that provides a font dialog box in which you 
can select a font name and size needs to be updated to provide a list of sizes. If the font dialog box allows you to 
specify the size of the font by typing it, you can specify whatever size you need, and the font will be displayed 
correctly due to the scalability of TrueType fonts. If you cannot type the font size, one point size is provided for you.

TASKBAR

In Windows CE 2.0, you can set your taskbar to autohide. This allows you to take advantage of the screen space 
occupied by the taskbar. Some 1.0 programs perform actions that prevent Windows CE from resizing the program 
window appropriately. Therefore, when the taskbar is first set to autohide, the active program does not appear to be 
resized to take advantage of the whole screen. Or when the autohide attribute is turned off, the active program does 
not resize to accommodate the taskbar. The workaround is to exit and restart the program (however, this workaround
does not always correct the problems with some version 1.0 programs).

SPECIFIC PROGRAMS (US and European Editions)

Following are known issues regarding specific programs. The manufacturers of these products have been contacted, 
and questions regarding the availability of updated software should be directed to the manufacturer.

· Microsoft PowerToys 1.0, Pocket Internet Explorer 1.1, and H/PC Converter Utility 1.0
PowerToys 1.0 and Pocket Internet Explorer 1.1 are not compatible with Windows CE 2.x devices. In addition, 
the H/PC Converter Utility 1.0 is not compatible with Windows CE Services 2.x or ActiveSync on your desktop
computer.    Please do not install these programs on    these releases.    Pocket Internet Explorer 1.1 is now 
replaced by Pocket Internet Explorer 2.0, which is included in Windows CE 2.x for the H/PC.    PowerToys 2.0 
and the H/PC Converter Utility for Windows CE 2.x are available at http:\\www.microsoft.com\windowsce.

· ART smARTwriter v1.0 
When starting smARTwriter, an internal error is reported. After installing, you can use the inking capability of 
smARTwriter in Pocket Word. However, the handwriting recognition does not work in Windows CE 2.0. Please 
contact ART about an update for Windows CE 2.0. 

· ART smARTwriter v1.0: InkPad 
The leftmost character cannot be selected unless you double-tap the character or use the keyboard. Tapping and 
dragging will not select the character. Please contact ART about an update for Windows CE 2.0.

· Freeware: Pocket Dial4Me v1.0 
The application cannot be minimized by pressing the taskbar button or by pressing the Desktop button on the 
right side of the taskbar. You must close Pocket Dial4Me after using it. In addition, this program is unable to 



load the Contacts database because it assumes a particular sort order for the database, and this sort order has 
changed.

· Freeware: Pocket Dial v1.0 
The application cannot be started under Windows CE 2.0 for the H/PC. Check http://www.windowsce.com for 
update plans.

· CIC: Jot v1.0 
On some H/PC's, Jot's inking and handwriting recognition may be slower than it was on 1.0 devices. Please 
contact CIC about an update for Windows CE 2.0.

If you are using v1.0 on an H/PC with a wide screen, such as the Hewlett Packard Palmtop PC, lines will appear
to the right of where you touch the screen. This issue is fixed in Jot 1.02.

When ink disappears (that is, when it's converted to text), it can leave a gray or white trail depending on what 
you inked over.

Some dialog text runs off the side of dialogs.

· CIC: QuickNotes v1.0
The background color in the thumbnail view is different from the color in the main window. In addition, the 
eraser changes the background to white rather than the original color. Please contact CIC about an update for 
Windows CE 2.0.

· Shareware: JimmyNotePad v1.0
The Symbol font is listed as an option in the Font dialog box. However, anything you format with the Symbol 
font will be displayed in Arial.

· Shareware: JimmySoft Calendar Search v1.0
The search completes correctly, but all items show "Error: No date" in the Date/Time column.

· Landware: TakeNote v1.0
Interaction between TakeNote and the Pocket Outlook Contacts database does not work. You cannot add a new 
entry to the Contacts database by using New Contact , nor can the Contacts database be started from the New 
Phone form. In addition, in a new Ink Note, if you tap the Information (I) button, the date appears with block 
characters. Please contact Landware about an update for Windows CE 2.0.

· Shareware: MG Notes v1.0
The Symbol font is listed as an option in the Font dialog box. However, anything you format with the Symbol 
font will be displayed in Arial.

· Odyssey: Pocket OnSchedule v1.0
Pocket Internet Explorer cannot be started using the Contacts    Visit Web Site command. You must instead copy
the Web site URL, start Pocket Internet Explorer from the desktop, and paste it in the Address box. Please 
contact Odyssey about an update for Windows CE 2.0.

Dialing options are not available in the Options dialog box.

Default items are not available in the Manage User Lists dialog box. Note that this problem only occurs on 
H/PCs with an SH3 processor (such as Hewlett Packard Palmtop PC and Casio A-10, A-11).

· Physix: Pocket Chart v1.0
The list box on the command bar extends off the right side of the screen. You can still tap the box to display the 
list. Please contact Physix about an update for Windows CE 2.0.

You can install Pocket Chart only to internal memory on the H/PC. You cannot install it to a PC Flash or SRAM



Card.

Some characters may be displayed as boxes (unrecognized characters) in the user interface.

Due to the complex nature of its layout, Pocket Chart exhibits several of the text issues detailed in "Font 
Display" in this section.

· Ruksun: Telnet Force v1.0
When the taskbar is hidden, Telnet Force is displayed in full screen mode. This causes the contents of any Telnet
site to be displayed in a font that is unreadable because it is so small. To work around the problem, clear the 
AutoHide option and then start Telnet Force. Ruksun is investigating this issue. Please contact Ruksun about an 
update for Windows CE 2.0.

On wide displays, such as the Hewlett Packard Palmtop PC, no scroll bar is displayed. There are some cases in 
which the text in the window is scrolled to the left of the screen so that the left edge is not visible. When this 
occurs, the text to the left of the screen cannot be accessed due to the absence of a scroll bar.

· Shareware: Invaders v1.0
This program cannot be started on Windows CE 2.0 for the H/PC.

· SkyTel: Messenger v1.0
Messages are delivered with square boxes (unrecognized characters) in place of carriage returns. Please contact 
SkyTel about an update for Windows CE 2.0.

· SpryNet: Sprynet v1.0 
After setting up the SpryNet transport in Inbox, you must reset the password you specified when setting up the 
transport. You can do this by going to step 1 of the Internet Mail service properties and retyping your password. 
Please contact Sprynet about an update for Windows CE 2.0.

· Symantec: PC Anywhere v1.0
PC Anywhere While connected to your PC, dragging icons on your PC desktop results in black trails being 
drawn on your H/PC screen. Symantec is investigating this issue. Please contact Symantec about an update for 
Windows CE 2.0.

· Wynd Communications: WyndMail v1.0
If you want to change properties after installing the WyndMail transport, open Inbox, tap Service, ensure 
WyndMail is selected, and then tap Properties. If you access the Properties dialog box by tapping Compose and 
then tapping Options, the dialog box title is cut off; consequently, you cannot move the dialog box or tap the 
OK or Cancel button. Please contact Wynd Communications about an update for Windows CE 2.0.

· Dataviz: Desktop To Go v1.0
If you install Desktop To Go after installing ActiveSync on your desktop computer, the filters are not available 
in the Conversion Settings dialog box. You must reinstall ActiveSync on your desktop computer after installing 
Desktop To Go for the filters to appear in the Conversion Settings dialog box. Please contact Dataviz about an 
update for Windows CE 2.0.

· Wright Strategies: FormLogic v1.0
After completing the desktop installation of FormLogic, use a command in the main program on the PC to 
initiate installation to your H/PC. This command is not available with ActiveSync installed on your desktop 
computer. Contact Wright Strategies for an update. Please contact Wright Strategies about an update for 
Windows CE 2.0.

SPECIFIC PROGRAMS (Japanese Edition)
Every effort has been made to ensure that v1,.0 applications designed for Windows CE v1.01 for the H/PC 
(Japanese Edition) will work on Windows CE v2.0 for the H/PC (Japanese Edition). If you see any problems 



with your v1.0 applications, please report them to your software vendor and inquire about updates for Windows 
CE v2.0 for the H/PC.

________________________________________________________________
4.0 PALM-SIZE PC CONTENTS

4.1 GENERAL
4.2 ACTIVE DESKTOP
4.3 CHANNELS
4.4 MICROSOFT POCKET OUTLOOK
4.5 NOTE TAKER
4.6 VOICE RECORDER
________________________________________________________________
4.1 GENERAL

· If device performance becomes poor over time, or if you notice odd behavior, reset your device to restore 
normal behavior. Instructions for resetting your Palm-size PC can be found in the manufacturer's instruction 
manual.

· Since Mobile Channel content contains formatting information, and not just text, strange characters may appear
when Find locates Mobile Channel content. This is normal, and the data will be displayed correctly in the 
Channels application.

________________________________________________________________
4.2 ACTIVE DESKTOP

· If a component on the Active Desktop is not refreshing properly, go to Settings > Display, uncheck the 
component, check it again, and tap OK. This will cause all Active Desktop components to reload, clearing any 
such problems.

________________________________________________________________
4.3 CHANNELS

· If you receive "Out of memory" messages on your desktop computer during channel synchronization, do the 
following. First, switch to Channels, go to View > Options, and tap OK without changing anything in the 
dialog box. This will make sure that the maximum storage limit is the full percentage shown in this dialog, 
instead of a fixed 200KB limit imposed the first time the device is turned on, as well as after a full reset (cold 
boot). If, after opening the dialog box and tapping OK you still receive frequent "Out of memory" messages, 
switch to Channels, go to View > Options, increase the % of storage memory value, and tap OK.

________________________________________________________________
4.4 MICROSOFT POCKET OUTLOOK

· Some appointment times may be off by one hour after they have been restored to a Palm-size PC 1.2 device.    
To resolve the problem, change the timezone on the device to any other timezone, then change it back to the 
original timezone.

MEETING REQUESTS

· If you wish to send meeting requests over a transport other than Window CE Inbox Services, in calendar, tap 
Tools > Options and select the new transport. For example, if you set up a POP3 e-mail transport and want to 
use it for sending both meeting requests and e-mail, you must set the transport in Calendar as well as in Inbox.

INBOX

· Meeting requests and attachments are downloaded via the Internet Email transport only if you select the 
applicable option in the Service Properties dialog box, step 3. Note that these options are not turned on by 
default. In addition, due to limitations of POP3, you must download a full copy of the message. Note that you 
can use Service > Retrieve Full Copy if you initially limit the number of lines.



· If you are accessing your e-mail via Microsoft Exchange POP3 server support and you send and receive 
meeting requests, have your mail administrator select the Download Microsoft Rich Text check box on the 
POP3 protocol page. This is required to receive meeting requests, but it will slow down mail transfer because 
more data is sent from the server for each message.

· Note that messages in your Inbox that came from Internet Mail or Inbox Sync are linked to those on the server, 
and deleting them on your device will delete them on the server.

· If you get an error when trying to send Internet Mail that says, in part, "There was an error specifying your 
return address to the server," you can try (after making sure your return address is correct) to either ask your ISP
to turn off strict RFC821 checking, or send mail via Inbox Sync or Inbox Transfer instead.

· Embedded OLE attachments and e-mail messages are not preserved in messages. Only file attachments are 
preserved.

INBOX SYNCHRONIZATION

· Message synchronization: you will receive duplicate messages if you are using Message Sync and the Internet 
Mail service to connect to the same mail server. To avoid this, it is recommended that you use Remote 
ActiveSync, rather than Internet Mail, to retrieve e-mail when using Remote Networking.

· Deleting messages from your Inbox on your desktop computer or device while you are synchronizing can 
sometimes cause messages to become "stuck" in your Deleted Items folder. If your synchronization status 
reports one or more items out of date despite repeated efforts to synchronize, follow these steps to correct the 
problem:

1. On the device, move the items from the Deleted Items folder to the Inbox folder.
2. On the device, create a new folder.
3. On the device, move the items that you undeleted in Step 1 from the Inbox folder to the new folder.
4. Synchronize the device with the desktop PC.

________________________________________________________________
4.5 NOTE TAKER

· Removing a storage card with a note open can cause data loss. Do not remove a storage card when a note stored
on this card is currently open.

· The Note Taker application main window list view does not refresh automatically when adding and/or removing
notes using the Mobile Devices folder on the desktop. To refresh your file list, switch to a different application 
on the Palm-size PC and back to Note Taker.

· To distinguish between a template saved on a storage card and one saved in storage (main) memory, look for an 
asterisk at the end of the template's name. Any template with an asterisk at the end of the name is saved on a 
storage card.

________________________________________________________________
4.6 VOICE RECORDER

· The Desktop Mobile Voice CODEC does not convert to PCM format if the voice recording is less than two 
seconds in duration. For example, if you have a voice recording that you wish to send to someone who does not 
have the Mobile Voice CODEC installed on their desktop machine, make sure that the recording is more than 2 
seconds in duration before converting it to PCM.

· The Voice Recorder application main window list view does not refresh automatically when adding and/or 
removing notes using the Mobile Devices folder on the desktop. To refresh your file list, switch to a different 
application on the Palm-size PC and back to Voice Recorder.



· Running processor-intensive applications may interfere with recording. This includes functionality such as a 
modem, such that on most devices, you will not be able to record while using the modem.


